Modular I/O System
ETHERNET StarterKit 2
510 376 07

Quick Start
ETHERNET Fieldbus Controller
750-841

Version 1.0.5
Copyright © 2008 by WAGO Kontakttechnik GmbH & Co. KG
All rights reserved.

WAGO Kontakttechnik GmbH & Co. KG
Hansastraße 27
D-32423 Minden
Phone.: +49 (0) 571/8 87 – 0
Fax: +49 (0) 571/8 87 – 1 69
E-Mail: info@wago.com
Web: http://www.wago.com

Technical Support
Phone: +49 (0) 571/8 87 – 5 55
Fax: +49 (0) 571/8 87 – 85 55
E-Mail: support@wago.com

Every conceivable measure has been taken to ensure the correctness and completeness of this documentation. However, as errors can never be fully excluded, we would appreciate any information or ideas at any time.

E-Mail: documentation@wago.com

We wish to point out that the software and hardware terms as well as the trademarks of companies used and/or mentioned in the present manual are generally trademark or patent protected.
CONTENT

1 Important Comments ................................................................................................. 4
  1.1 Legal Principles .................................................................................................. 4
  1.1.1 Copyright ...................................................................................................... 4
  1.1.2 Personnel Qualification ................................................................................. 4
  1.1.3 Intended Use .................................................................................................. 4
  1.2 Symbols ............................................................................................................... 5
  1.3 Number Notation ............................................................................................... 5
  1.4 Safety Notes ....................................................................................................... 6
  1.5 Scope ................................................................................................................... 6

2 Quick Start ............................................................................................................... 7
  2.1 Node Assembly .................................................................................................. 7
  2.2 Ethernet Network Start-Up ............................................................................... 8
  2.3 The First Program ............................................................................................. 13
  2.4 Program Download to the Controller 750-841 ................................................ 18
  2.5 Alternative to the Variable Declaration in the PLC Configuration.................. 18
  2.6 Modbus/TCP DLL Application Examples ....................................................... 19
  2.7 Information for Programming and Web Visualization ..................................... 20

3 Addressing ............................................................................................................... 21
  3.1 Comparison of Modbus and IEC1131 Addresses ............................................ 21
  3.1.1 WORD Access ............................................................................................ 22
  3.1.2 Bit Access .................................................................................................... 24
1 Important Comments

To ensure fast installation and start-up of the units described in this manual, we strongly recommend that the following information and explanations are carefully read and abided by.

1.1 Legal Principles

1.1.1 Copyright

This manual is copyrighted, together with all figures and illustrations contained therein. Any use of this manual which infringes the copyright provisions stipulated herein, is not permitted. Reproduction, translation and electronic and photo-technical archiving and amendments require the written consent of WAGO Kontakttechnik GmbH & Co. KG. Non-observance will entail the right of claims for damages.

WAGO Kontakttechnik GmbH & Co. KG reserves the right to perform modifications allowed by technical progress. In case of grant of a patent or legal protection of utility patents all rights are reserved by WAGO Kontakttechnik GmbH & Co. KG. Products of other manufacturers are always named without referring to patent rights. The existence of such rights can therefore not be ruled out.

1.1.2 Personnel Qualification

The use of the product detailed in this manual is exclusively geared to specialists having qualifications in PLC programming, electrical specialists or persons instructed by electrical specialists who are also familiar with the valid standards. WAGO Kontakttechnik GmbH & Co. KG declines all liability resulting from improper action and damage to WAGO products and third party products due to non-observance of the information contained in this manual.

1.1.3 Intended Use

For each individual application, the components supplied are to work with a dedicated hardware and software configuration. Modifications are only permitted within the framework of the possibilities documented in the manuals. All other changes to the hardware and/or software and the non-conforming use of the components entail the exclusion of liability on part of WAGO Kontakttechnik GmbH & Co. KG.

Please direct any requirements pertaining to a modified and/or new hardware or software configuration directly to WAGO Kontakttechnik GmbH & Co. KG.
1.2 Symbols

**Danger**
Always abide by this information to protect persons from injury.

**Warning**
Always abide by this information to prevent damage to the device.

**Attention**
Marginal conditions must always be observed to ensure smooth operation.

**ESD (Electrostatic Discharge)**
Warning of damage to the components by electrostatic discharge. Observe the precautionary measure for handling components at risk.

**Note**
Routines or advice for efficient use of the device and software optimization.

**More information**
References on additional literature, manuals, data sheets and INTERNET pages

1.3 Number Notation

<table>
<thead>
<tr>
<th>Number Code</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>100</td>
<td>normal notation</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0x64</td>
<td>C notation</td>
</tr>
<tr>
<td>Binary</td>
<td>'100'</td>
<td>Within ',', Nibble separated with dots</td>
</tr>
<tr>
<td></td>
<td>'0110.0100'</td>
<td></td>
</tr>
</tbody>
</table>
1.4 Safety Notes

Attention
Switch off the system prior to working on bus modules!

In the event of deformed contacts, the module in question is to be replaced, as its functionality can no longer be ensured on a long-term basis.

The components are not resistant against materials having seeping and insulating properties. Belonging to this group of materials is: e.g. aerosols, silicones, triglycerides (found in some hand creams).

If it cannot be ruled out that these materials appear in the component environment, then additional measures are to be taken:
- installation of the components into an appropriate enclosure
- handling of the components only with clean tools and materials.

Attention
Cleaning of soiled contacts may only be done with ethyl alcohol and leather cloths. Thereby, the ESD information is to be regarded.

Do not use any contact spray. The spray may impair the functioning of the contact area.

The WAGO-I/O-SYSTEM 750 and its components are an open system. It must only be assembled in housings, cabinets or in electrical operation rooms. Access must only be given via a key or tool to authorized qualified personnel.

The relevant valid and applicable standards and guidelines concerning the installation of switch boxes are to be observed.

ESD (Electrostatic Discharge)
The modules are equipped with electronic components that may be destroyed by electrostatic discharge. When handling the modules, ensure that the environment (persons, workplace and packing) is well grounded. Avoid touching conductive components, e.g. gold contacts.

1.5 Scope

These quick start instructions describe the ETHERNET StarterKit 2 with the Ethernet fieldbus controller 750-841 and some basic components of the WAGO-I/O-SYSTEM 750.

You will find detailed information about operation, assembly and start-up in the manuals “Ethernet TCP/IP 750-841“ and “WAGO-I/O-PRO CAA“. This documentation is hence only valid in connection with the appropriate manuals.

Further information
You can also find the manuals “Ethernet TCP/IP 750-841“ and “WAGO-I/O-PRO CAA“ on our “WAGO-I/O-PRO CAA“ CD-ROM (759-911) and in the Internet under www.wago.com.
2 Quick Start

2.1 Node Assembly

Build up the fieldbus node as follows (from left to right):

750-841; 750-400; 750-501; 750-600.

Connect the supplies for the controller and for the power jumper contacts to the DC 24 V power supply unit 787-602 (see Fig.1).

In this example it would be sufficient to bridge “24V“ and “+“ or “0V“ and “-“.

Fig.1: 10/100 MBit ETHERNET fieldbus controller 750-841
2.2 Ethernet Network Start-Up

Allocating the IP address is done very conveniently using both the included serial programming cable and the “WAGO Ethernet Settings“ program. Connect your PC with the configuration and programming interface of the node.

Install the “WAGO Ethernet Settings“ program, which you can find either on the “Tools & Docs“ CD-ROM or on the WAGO Web pages under Service → Downloads → Software. After starting, the program identifies the current settings of the node.

If a connection timeout occurs, you can retry the connection by using the “Identify“ button. If the problem persists, check the COM port settings and cabling.
An IP address always consists of both network and computer addresses. The network mask determines which bits belong to the network address and which do not.

![Settings of the PC network card](image)

Select a free computer address from the local network. You can find out the network address of your PC under Start ➔ Settings ➔ Network and Dial-up connections ➔ LAN connection x ➔ Properties. To do so, select the Internet protocol (TCP/IP) from the selection list and press the "Properties“ button.

**Attention**
Assigning IP addresses twice can lead to serious network failures.
Click on the “TCP/IP” tab and enter an IP address for the node. Then, press the "Write" button to write the change to the node.

![WAGO Ethernet Settings](image)

Fig. 4: Settings of the 750-841 Controller IP address

Now connect the node to the Ethernet network either directly to a PC using a crossover cable or to a Hub or Switch using a 1-to-1 patch cable.

**Attention**
The IP address of the controller can also be assigned using the "WAGO BootP Server" instead of the "WAGO Ethernet Settings". In this case, the allocation is done via the Ethernet interface of the device so that no separate serial cable is required. However, the assigned IP address will only be used temporarily. In the Web Base Management (WBM), the BootP protocol must be deactivated subsequently in order to save the IP address permanently.
To test the connection, open the DOS shell via Start → Programs → Accessories → Command prompt, and send a PING to the IP address of the node.

Fig. 5: Testing the connection to the 750-841 Controller with "Ping"

If you get no response from the node, contact your network administrator.

All settings can also be viewed and modified via the Web-Based Management (WBM).
To do so, start your browser and enter http:// followed by the IP address of the node (e.g. http://192.168.1.12).

The integrated Web server generates the following Web page:

Fig. 6: Home page of the 750-841 Controller’s integrated WEB server
When using a proxy server, the proxy server must be bypassed for local addresses. Information on how to bypass the proxy server for local addresses can be found in the help section of your browser under “Proxy server” or “LAN settings”.

A login is required to access the configuration pages via hyperlinks. The following users are created by default:

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>wago</td>
</tr>
<tr>
<td>user</td>
<td>user</td>
</tr>
<tr>
<td>guest</td>
<td>guest</td>
</tr>
</tbody>
</table>

Fig. 7: Users and passwords of the 750-841 Controller’s WEB server

Using firmware version (09) and above, the process data can be displayed in the right window of the "IO config" configuration page. Access to process data is based on the “GenIoConf.xml“ file in the “etc“ folder of the node’s file system. Data generation is disabled by default and can be activated on the “Features“ configuration page.

Fig. 8: “IO config“ page of the integrated WEB server

The left-side window of the “IO config“ configuration page shows the hardware configuration that has been created by CoDeSys as usual. Write permission to the outputs is assigned by the hardware configuration either to the “PLC“, the fieldbus 1(Modbus) or the fieldbus 2 (Ethernet_IP).
2.3 The First Program

Prerequisite:
The WAGO-I/O-PRO CAA software (CoDeSys) has to be installed correctly and started.

You can start a new project via ➔ File ➔ New.

Example:

Before programming the 750-841 controller, select the controller in the “Target Settings” window.

Fig. 9: Target settings

Please select the “WAGO_750-841“ target in this window.

In use of WAGO-I/O-PRO CAA, starting from version 2.3.9.3, you select the target system "WAGO_750-841_(FW12 -...)", if the WAGO Ethernet Controller 750-841 has already the firmware version 13.

This is to recognize on the basis of the manufacturing number, look at the 5th and 6th number.

Further information
Detailed Information about the manufacturing number, please refer to the manual „Ethernet TCP/IP 750-841”.

You can find this manual on the CD-ROM „WAGO-I/O-PRO CAA“ (759-911), on the CD-ROM „ELECTRONICC Tools & Docs“ (Item.-No.: 0888-0412/0001-0101) and also on the Internet under:

www.wago.com

Then confirm the selected target with “OK“ in the dialog box above.

A POU can now be created in the following dialog box. In this example, a new “PLC_PRG“ is created in “ST“ programming language (Fig. 10).
Before starting to create a POU, a PLC configuration must be performed.

To do so, change to PLC configuration in the “Resources“ register.

Select „K-Bus[FIX]“ in the PLC configuration and then right-click the mouse to open the context menu.
Select "Append sub-element". This will open the I/O configuration window with the I/O module catalog.

In the application example shown in section 2.1, a single 750-400 digital input module has been connected to the 750-841 controller, followed by a 750-501 digital output module. The 750-600 end module is arranged on the very right hand side.

In the I/O module catalog on the left, first click on “Digital Input” to select the 750-400 module and then move this module to the right into your selection using the “Insert“ button.

Then, select the 750-501 module from the I/O module catalog on the left by clicking on “Digital Output” and move it to the right into your selection using the “Insert“ button.

If you wish to delete some modules from your selection, select the appropriate module on the right-hand side and click the "Delete“ button.
You can change the position of a module in your selection by selecting and moving the module using the up and down arrow buttons on the right-hand side of the window.

The 750-600 end module is not shown in the I/O configuration window.

Then confirm your selection with “OK“.

For each I/O module, you can now determine via Module parameters if the outputs of a module will be controlled by the controller (PLC) or by a particular Ethernet protocol (fieldbus 1 = Modbus/TCP or fieldbus 2 = Ethernet/IP) (Fig. 14).

![Fig. 14: WAGO-I/O-PRO CAA, PLC configuration with 750-400 and -501](image)

In this example, we first used the “PLC“ value.

The I/O configuration window now shows the address of each channel, and thus each individual bit on the module.
Left clicking on the arrow next to “AT“ will open a text box in which you can enter a variable name (Fig. 15).

![Image of WAGO-I/O-PRO, Declaration of variables with I/O configuration dialog](image1)

Fig. 15: WAGO-I/O-PRO, Declaration of variables with I/O configuration dialog

Now enter the following variable names:

Input_Bit1 (for the %IX0.0 address)
Input_Bit2 (for the %IX0.1 address)
Output_Bit1 (for the %QX0.0 address)
Output_Bit2 (for the %QX0.1 address)

Then, open the “PLC_PRG“ program from the “POUs“ register and complete a simple assignment within the statement part of the program:

Output_Bit1 := Input_Bit1;
Output_Bit2 := Input_Bit2;

![Image of WAGO-I/O-PRO CAA, Declaration and statement part of the PLC-PRG program](image2)

Fig. 16: WAGO-I/O-PRO CAA, Declaration and statement part of the PLC-PRG program

This way, both the first two inputs and first two outputs are assigned to each other (Fig. 16).

The program can now be loaded if the test program has been successfully compiled.

Compilation is initiated via ➔ Project ➔ Rebuild all.
2.4 Program Download to the Controller 750-841

Click → Communication Parameters in the online menu and create a new communication channel.
Choose EthernetTCP/IP (3S TCP/IP driver).

Enter the IP address of the coupler under “Address“ (e.g. 192.168.1.12).
Enter port number 2455.

Please note that the simulation is deactivated.

You can now download the program via → Online → Login.

Start the program via → Online → Run.

Note
If the program should be permanently stored and be available without re- newed download on the Controller after a voltage failure, the menu “Online” -→ “Create Boot Project” is selected in the logged in condition. Thus the compiled project is stored zero potential protected in the Flash memory. So that the Controller starts the program automatically after voltage return, the mode switch (fig. 1) is to switch into the upper position „RUN“.

2.5 Alternative to the Variable Declaration in the PLC Configuration

Instead of addressing bits individually and globally in the PLC configuration, a whole byte can also be addressed locally in the declaration part of the “PLC-PRG“ program.

Open the “PLC_PRG“ program under the “POUs“ register and declare the local process image as follows:

Input_BYTE AT %IB0: BYTE;
Output_BYTE AT %QB0: BYTE;

[Fig. 17: WAGO-I/O-PRO CAA, Declaration and statement part of the PLC-PRG program]

A simple assignment in the statement part of the program could be:

Output_BYTE := Input_BYTE;
This way, the inputs are assigned to the outputs (Fig. 17).

The program can now be loaded if the test program has been successfully compiled.

Compilation is activated via → Project → Rebuild all.
(Continue in section 2.4 “Program Download to the 750-841 Controller”)

2.6 Modbus/TCP DLL Application Examples

Also included is the “WAGO DLL Modbus/TCP“ (759-312) CD-ROM. The DynamicLinkLibrary (DLL) encapsulates the functionality of a Modbus master hence facilitating the creation of your own Windows-based applications. The procedural DLL can be used in almost any programming language. On the CD-Rom, you will find examples for Excel VBA, ”Visual Basic 6“, ”vb.net“, ”Delphi 5“, ”MS Visual C++ 6“, ”C#“ and ”LabVIEW 7“.

In addition, you will find the two ActiveX components “ActiveMBT“(Master) and “ActiveMBTSlave“ that are used in Visual Basic. Registration is provided by a setup program that will also install the “Modbus Monitor“ program shown below.

Fig. 18: Modbus/TCP DLL, Modbus Monitor

The “Modbus Monitor“ provides a graphical user interface for all functionalities of the “ActiveMBT“ ActiveX code component and allows reading and writing of data via the Modbus protocol.

Further information and examples can be found on the ”WAGO DLL Modbus/TCP“ (759-312) CD-ROM.
2.7 Information for Programming and Web Visualization

Further information
Detailed Information about the programming and visualization, especial the Web Visualization, please refer to the manuals „WAGO-I/O-PRO CAA (CoDeSys)“. You can find these manuals on the CD-ROM „WAGO-I/O-PRO CAA“ (759-911), on the CD-ROM „ELECTRONIC Tools & Docs“ (Item.-No.: 0888-0412/0001-0101) and also on the Internet under: www.wago.com
3 Addressing

3.1 Comparison of Modbus and IEC1131 Addresses

In this section, you will find a list of memory ranges for both the Modbus addressable 750-841 Controller and 750-341 Coupler.

The following address spaces are available for Modbus communication using the 750-841 Controller from WAGO.

<table>
<thead>
<tr>
<th>Address space</th>
<th>Modbus access</th>
<th>PLC access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phys. inputs (1)</td>
<td>read</td>
<td>read</td>
<td>Physical inputs 1(%IW0 ... %IW255)</td>
</tr>
<tr>
<td>Phys. outputs (1)</td>
<td>read/write</td>
<td>read/write</td>
<td>Physical outputs 1 (%QW0 ... %QW255)</td>
</tr>
<tr>
<td>PFC-IN variables</td>
<td>read/write</td>
<td>read</td>
<td>Volatile PLC input variables (%IW256 ... %IW511)</td>
</tr>
<tr>
<td>PFC-OUT variables</td>
<td>read/write</td>
<td>read/write</td>
<td>Volatile PLC output variables (%QW256 ... %QW511)</td>
</tr>
<tr>
<td>Configuration register</td>
<td>read/write</td>
<td>---</td>
<td>See manual</td>
</tr>
<tr>
<td>Firmware register</td>
<td>read</td>
<td>---</td>
<td>See manual</td>
</tr>
<tr>
<td>RETAIN variables</td>
<td>read/write</td>
<td>read/write</td>
<td>Remanent memory (%MW0 ... %MW12288)</td>
</tr>
<tr>
<td>Phys. inputs (2)</td>
<td>read</td>
<td>read</td>
<td>Physical inputs 2(%IW512 ... %IW1275)</td>
</tr>
<tr>
<td>Phys. outputs (2)</td>
<td>read/write</td>
<td>read/write</td>
<td>Physical outputs 2 (%QW512 ... %QW1275)</td>
</tr>
</tbody>
</table>

In contrast to the WAGO 750-841 Controller, only the following address spaces are available when communicating via the WAGO 750-341 Coupler:

<table>
<thead>
<tr>
<th>Address space</th>
<th>Modbus access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phys. inputs (1)</td>
<td>read</td>
<td>Physical inputs 1(%IW0 ... %IW255)</td>
</tr>
<tr>
<td>Phys. outputs (1)</td>
<td>read/write</td>
<td>Physical outputs 1(%QW0 ... %QW255)</td>
</tr>
<tr>
<td>Configuration register</td>
<td>read/write</td>
<td>See manual</td>
</tr>
<tr>
<td>Firmware register</td>
<td>read</td>
<td>See manual</td>
</tr>
<tr>
<td>Phys. inputs (2)</td>
<td>read</td>
<td>Physical inputs 1(%IW512 ... %IW1275)</td>
</tr>
<tr>
<td>Phys. outputs (2)</td>
<td>read/write</td>
<td>Physical outputs 1(%QW512 ... %QW1275)</td>
</tr>
</tbody>
</table>

Modbus addresses are merely a numerical value from 0 to 65535 which is used to determine the start address of an operation. The type of operation like writing and/or reading word or digital signals is defined by the “FunctionCode“.

In Modbus, a register represents a 16-bit value (WORD) and a “coil“ is a digital output (BIT).

Further information about Modbus can be found in the manual.
### 3.1.1 WORD Access

The following tables display the MODBUS addressing and the corresponding IEC61131 addressing for the process image, the PFC variables, the NOVRAM data, and the internal variables is represented.

Via the register services the states of the complex and digital I/O modules can be determined or changed.

**Register (Word) Access Reading (with FC3, FC4 and FC23):**

<table>
<thead>
<tr>
<th>Modbus-Address [dec]</th>
<th>Modbus-Address [hex]</th>
<th>IEC61131 Address</th>
<th>Memory Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0x0000</td>
<td>%IW0</td>
<td>Physical Input Area (1)</td>
</tr>
<tr>
<td>... 255</td>
<td>... 0x00FF</td>
<td>%IW255</td>
<td>First 256 Words of physical input data</td>
</tr>
<tr>
<td>256</td>
<td>0x0100</td>
<td>%QW256</td>
<td>PFC-OUT-Area</td>
</tr>
<tr>
<td>... 511</td>
<td>... 0x01FF</td>
<td>%QW511</td>
<td>Volatile PFC Output variables</td>
</tr>
<tr>
<td>512</td>
<td>0x0200</td>
<td>%QW0</td>
<td>Physical Output Area (1)</td>
</tr>
<tr>
<td>... 767</td>
<td>... 0x02FF</td>
<td>%QW255</td>
<td>First 256 Words of physical output data</td>
</tr>
<tr>
<td>768</td>
<td>0x0300</td>
<td>%IW256</td>
<td>PFC-IN-Area</td>
</tr>
<tr>
<td>... 1023</td>
<td>... 0x03FF</td>
<td>%IW511</td>
<td>Volatile PFC Input variables</td>
</tr>
<tr>
<td>1024</td>
<td>0x0400</td>
<td>-</td>
<td>Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>... 4095</td>
<td>... 0x0FF</td>
<td>-</td>
<td>Configuration Register</td>
</tr>
<tr>
<td>4096</td>
<td>0x1000</td>
<td>0x1000</td>
<td>-</td>
</tr>
<tr>
<td>... 12287</td>
<td>... 0x2FF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12288</td>
<td>0x3000</td>
<td>%MW0</td>
<td>NOVRAM</td>
</tr>
<tr>
<td>... 24575</td>
<td>... 0x5FF</td>
<td>%MW2287</td>
<td>8kB retain memory (max. 24kB)</td>
</tr>
<tr>
<td>24576</td>
<td>0x6000</td>
<td>%IW12</td>
<td>Physical Input Area (2)</td>
</tr>
<tr>
<td>... 25340</td>
<td>... 0x6FF</td>
<td>%IW1275</td>
<td>Additional 764 Words physical input data</td>
</tr>
<tr>
<td>25341</td>
<td>0x62FD</td>
<td>-</td>
<td>Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>... 28671</td>
<td>... 0x6FF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28672</td>
<td>0x7000</td>
<td>%QW12</td>
<td>Physical Output Area (2)</td>
</tr>
<tr>
<td>... 29436</td>
<td>... 0x7FF</td>
<td>%QW1275</td>
<td>Additional 764 Words physical output data</td>
</tr>
<tr>
<td>29437</td>
<td>0x72FD</td>
<td>-</td>
<td>Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>... 65535</td>
<td>... 0xFFFF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Register (Word) Access Writing (with FC6, FC16, FC22 and FC23):

<table>
<thead>
<tr>
<th>Modbus-Address [dec]</th>
<th>IEC61131 Address [hex]</th>
<th>Memory Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0x0000 ... 0x00FF</td>
<td>%QW0 ... %QW255 Physical Output Area (1)</td>
</tr>
<tr>
<td>256</td>
<td>0x0100 ... 0x01FF</td>
<td>%IW256 ... %IW511 PFC-IN-Area</td>
</tr>
<tr>
<td>512</td>
<td>0x0200 ... 0x02FF</td>
<td>%QW0 ... %QW255 Physical Output Area (1)</td>
</tr>
<tr>
<td>768</td>
<td>0x0300 ... 0x03FF</td>
<td>%IW256 ... %IW511 PFC-IN-Area</td>
</tr>
<tr>
<td>1024</td>
<td>0x0400 ... 0x04FF</td>
<td>- Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>4096</td>
<td>0x1000 ... 0x10FF</td>
<td>- Configuration Register</td>
</tr>
<tr>
<td>12288</td>
<td>0x3000 ... 0x30FF</td>
<td>%MW0 ... %MW12287 NOVRAM</td>
</tr>
<tr>
<td>24576</td>
<td>0x6000 ... 0x60FF</td>
<td>%QW512 ... %QW1275 Physical Output Area (2)</td>
</tr>
<tr>
<td>25341</td>
<td>0x62FD ... 0x6FF</td>
<td>- Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>28672</td>
<td>0x7000 ... 0x72FF</td>
<td>%QW512 ... %QW1275 Physical Output Area (2)</td>
</tr>
<tr>
<td>29437</td>
<td>0x72FD ... 0xFFF</td>
<td>- Modbus Exception: “Illegal data address”</td>
</tr>
</tbody>
</table>
3.1.2 Bit Access

The digital Modbus services (coil services) are Bit accesses, with which only the states of digital I/O modules can be determined or changed. Complex I/O modules are not attainable with these services and so they are ignored. Because of this the addressing of the digital channels begins again with 0, so that the MODBUS address is always identical to the channel number, (i.e. the digital input no. 47 has the MODBUS address "46").

Bit Access Reading (with FC1 and FC2):

<table>
<thead>
<tr>
<th>Modbus-Address</th>
<th>Memory Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ... 511</td>
<td>0x0000 ... 0x01FF</td>
<td>Physical Input Area (1)</td>
</tr>
<tr>
<td>512 ... 1023</td>
<td>0x0200 ... 0x03FF</td>
<td>Physical Output Area (1)</td>
</tr>
<tr>
<td>1024 ... 4095</td>
<td>0x0400 ... 0x0FFF</td>
<td>-</td>
</tr>
<tr>
<td>4096 ... 8191</td>
<td>0x1000 ... 0x1FFF</td>
<td>%QX256.0 ... %QX511.15</td>
</tr>
<tr>
<td>8192 ... 12287</td>
<td>0x2000 ... 0x2FFF</td>
<td>%IX256.0 ... %IX511.15</td>
</tr>
<tr>
<td>12288 ... 32767</td>
<td>0x3000 ... 0x7FFF</td>
<td>%MX0 ... %MX1279.15</td>
</tr>
<tr>
<td>32768 ... 34295</td>
<td>0x8000 ... 0x85F7</td>
<td>Physical Input Area (2)</td>
</tr>
<tr>
<td>34296 ... 36863</td>
<td>0x85F8 ... 0x8FFF</td>
<td>-</td>
</tr>
<tr>
<td>36864 ... 38391</td>
<td>0x9000 ... 0x95F7</td>
<td>Physical Output Area (2)</td>
</tr>
<tr>
<td>38392 ... 65535</td>
<td>0x95F8 ... 0xFFFF</td>
<td>-</td>
</tr>
</tbody>
</table>
Addressing
Comparison of Modbus and IEC1131 Addresses

Bit Access Writing (with FC5 and FC15):

<table>
<thead>
<tr>
<th>Modbus-Address</th>
<th>Memory Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ... 511</td>
<td>0x0000 ... 0x01FF</td>
<td>Physical Output Area (1) First 512 digital outputs</td>
</tr>
<tr>
<td>512 ... 1023</td>
<td>0x0200 ... 0x03FF</td>
<td>Physical Output Area (1) First 512 digital outputs</td>
</tr>
<tr>
<td>1024 ... 4095</td>
<td>0x0400 ... 0x0FFF</td>
<td>- Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>4096 ... 8191</td>
<td>0x1000 ... 0x1FFF</td>
<td>%IX256.0 ... %IX511.15 PFC-IN-Area Volatile PFC Input variables</td>
</tr>
<tr>
<td>8192 ... 12287</td>
<td>0x2000 ... 0x2FFF</td>
<td>%IX256.0 ... %IX511.15 PFC-IN-Area Volatile PFC Input variables</td>
</tr>
<tr>
<td>12288 ... 32767</td>
<td>0x3000 ... 0x7FFF</td>
<td>%MX0 ... %MX1279.15 NOVRAM 8kB retain memory (max. 24kB)</td>
</tr>
<tr>
<td>32768 ... 34295</td>
<td>0x8000 ... 0x85F7</td>
<td>Physical Output Area (2) Starts with the 513th and ends with the 2039th digital output</td>
</tr>
<tr>
<td>34296 ... 36863</td>
<td>0x85F8 ... 0x8FFF</td>
<td>Modbus Exception: “Illegal data address”</td>
</tr>
<tr>
<td>36864 ... 38391</td>
<td>0x9000 ... 0x95F7</td>
<td>Physical Output Area (2) Starts with the 513th and ends with the 2039th digital output</td>
</tr>
<tr>
<td>38392 ... 65535</td>
<td>0x95F8 ... 0xFFFF</td>
<td>Modbus Exception: “Illegal data address”</td>
</tr>
</tbody>
</table>

Note
The “DigitalOffSet“ of the digital inputs is 0, when no analog input modules / specialty modules and no ”SET_DIGITAL_INPUT_OFFSET“ POU (from the ”mod_com.lib“ library) are used.
The “DigitalOffSet“ of the digital outputs is 0, when no analog output modules / specialty modules and no “SET_DIGITAL_OUTPUT_OFFSET“ POU (from the “mod_com.lib“ library) are used.